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TALS User’s Guide 
 

This user’s guide may assist budget staff build an initial allotment submittal using The Allotment System 
(TALS) Allotment Management and Review (AMR). The sample allotment submittal created uses the basic 
features of TALS AMR. The guide will outline differences in access and system usage based on security 
level where needed.   
 
Guide conventions: 
Functions are in Bold.   
Specific business rules and recommendations for entering allotment submittals are denoted with a   
 
For specific guidelines in effect please refer to the OFM Allotment Instructions as they are updated for each 
biennium and supplemental budget. The TALS AMR User’s Guide is also available online in the Budget 
Works Library. The library may also be accessed by the help link within the application. 
 

Logging on and browser settings 
 
Open Microsoft Edge or Google Chrome and enter the login address 
https://budgetlogon.ofm.wa.gov/Logon.aspx  in the address bar of the browser. 
 
Enter your login ID and password to log into BudgetWorks. If you do not have access please use the 
Security Request Form to request it through the OFM Helpdesk at HereToHelp@ofm.wa.gov. The menu 
will only show the applications that the user has permission to access.  
 

 

How to Disable Pop-Up Blockers 
TALS has pop-up notifications and instructions, to enable pop-ups or verify pop-ups are allowed, please 
follow the steps below.    
• Beside the address bar, select the … which will display a drop-down menu 
• Select Settings, this will open a new menu, on the left side select Cookies and site permissions 
• Scroll down to Pop-ups and redirects, beside Allow, select Add, enter the site 

https://budgetlogon.ofm.wa.gov and click Add again. 
 
 
 
 

https://www.ofm.wa.gov/budget/budget-instructions/allotment-instructions
https://budgetlogon.ofm.wa.gov/library/default.htm
https://budgetlogon.ofm.wa.gov/library/default.htm
https://budgetlogon.ofm.wa.gov/Logon.aspx
https://budgetlogon.ofm.wa.gov/library/BudgetWorksSecurityForm.pdf
mailto:HereToHelp@ofm.wa.gov
https://budgetlogon.ofm.wa.gov/
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In Edge:  

 

 Note: Documents downloaded in Edge may appear in a new browser tab instead of a document reader 
such as Adobe or Excel and the following warning may appear.  

Internet Explorer Compatibility Mode 
 
1. Beside the address bar, select the … which will display a drop-down menu 
2. Select Settings, this will open a new menu, on the left side select Default Browser 
3. Scroll down to Internet Explorer Compatibility, Incompatible Sites Only 
4. Select Allow, enter the site address, and click Add  

 
 
Once the steps are complete, the address bar should 
display the IE in the address bar.  
 
Note: IE7 may vary depending on which IE version has 
been downloaded by the agency.  
 
 
 
 
 
 
 

.  
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Getting to know TALS 
 

All navigation bars and selection tabs remain in the same place on each page. The selection tabs run 
horizontally across the top of each screen, allowing for the selection of screen features and system navigation. 
Shortcut links on the application tab bar and the breadcrumb bar can “jump” to previously viewed pages 
without using the browser Back button.  

Application Bar – this bar is always available and includes a tab for the functional areas  

 
 

• View Packet List –View the list of agency allotment packets for the biennium, by selecting a specific 
packet other tabs and choices will be enabled. 

• Online Views – chose filter options for the selected packet to export specific information in Excel.    
• Enterprise Reporting (ER) – opens up the Enterprise Reporting login page to access other available 

reports. A list of common reports can be found on page  
• Charts – Run a variety of charts displaying allotment packets that are in pending, review, and approved 

statuses. Charts can run scenario vs actual data by account, program, or object. 
 

Breadcrumb Bar - allows navigation back to a previously viewed screen based on the current screen. 

 
 

Select Biennium and how many rows to view on each screen. Load to view the selected criteria 

 
Contact, Help & Logout  

                                    
 

• Contact: Opens the OFM Budget Staff Agency Assignment page for a list of current agency specific 
Budget Analysts for further assistance. 

• Help: Opens the System Help & Tutorials page.   
• Log out:  Exit the TALS Application 
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Allotment Packet(s) 
Allotments are detailed plans (or amendments to plans) of the scheduled revenues and expenditures 
authorized in the budget and the related cash receipts and cash disbursements. Agencies submit these 
allotment plans to OFM for review using the TALS AMR system. Prior to entering new allotment data into AMR, 
the agency needs to establish a new allotment packet. An allotment packet is a container in which allotment 
records are created for a specific allotment purpose. 

The Add Packet feature creates a new allotment packet on the View Packet List screen. This packet will be 
assigned a system generated four-digit number used to identify the allotment packet and displays descriptive 
information pertaining to the packet.   

 Note: This feature is not available for those with read only security access.  

The following steps creates a new allotment packet with packet descriptive elements, adding narrative 
comments that support the allotment, as well as, adding attachments that are needed by an OFM budget 
analyst in the allotment review process.  

After Logging in to TALS AMR, the View Packet List screen is displayed.  

 
 
1. Select the Biennium using the dropdown box, and then the Load button. The status bar in the lower right-

hand corner shows the page load briefly.  

2. Select the Add Packet tab in the upper left-hand corner of the View Packet List screen.  

3. On the Add Packet screen, the Packet Number will remain listed as [unassigned] until the required packet 
elements have been selected and saved for the packet being added. This is a system generated number 
and deleted packet numbers will not be reused.  

4. Verify the Biennium. This dropdown will default to the biennium selected on the View Packet List screen.  
 Note: Once a packet has been saved this field cannot be updated.  

5. Select a packet type from the Purpose dropdown box. The packet purpose describes the reason for the 
allotment submittal. The initial allotment requires an initial allotment packet purpose type. Please refer to 
the allotment instructions for more information on the packet purposes to use for allotment amendments.  
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1. Select a Program from the dropdown list
 Note: If a program is not required, the drop down should state [No Program Selected]. Program

selection is a requirement for DSHS.
2. Enter a packet Title, generally title as a short description.
3. Enter a Packet Explanation with information to be communicated to an OFM budget analyst.

 Note: While this field is not required to save an allotment packet, an explanation is often required
by the OFM allotment instructions. If an explanation is required and missing, a critical pre-release
edit check message is returned during the submission process to update the required field.

4. Enter Agency Internal Comments that capture detailed agency assumptions or comments intended only
for internal use. Comments in this section are not viewable by OFM.

5. Select an individual from the Primary Contact dropdown list who is the agency spokesperson for
questions concerning the allotment data and its assumptions.

6. The contact field is populated based on security forms submitted to OFM. The chosen contact will be the
person receiving e-mail issues in relation to the packet. The contact can be changed in review and
approved status.

7. Select an individual from the Secondary Contact dropdown list who is a secondary contact for the agency.
8. Attachments is an optional field, except for unanticipated receipts. If adding a packet, the Add Attachments button

will only be enabled after the packet details have been saved.

Add Packet Screen Fields: 

Field Required Description Comments 
Biennium Yes Not editable after save 
Purpose Yes Purpose or type of allotment Not editable after save 
Program No* Used to identify and sort allotment packets 

that contain allotment detail for one 
program 
*Required for DSHS

There is no system edit between the 
Program field selection and the allotment 
detail included in the packet 

Title No Identify and describe the allotment packet 
data.   
Visible on the View Packets List screen. 

Editable when packet is in a Draft or 
returned status. 

Packet 
Explanation 

* Communicates to OFM the key 
assumptions and decisions in the allotment 
packet data. 

*Not required to save the packet but the
OFM allotment instructions do require
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agencies to submit explanations in certain 
cases. 

Agency 
Internal 
Comment 

No Documents agency decisions and 
assumptions  

Visible only to the agency 

Primary 
Contact 

Yes Defaults to the name, email address and 
phone number of the person who created 
the packet 

 

Secondary 
Contacts 

No Add additional contact information for the 
packet 

 

Attachments No  Word, Excel & PDF documents only 
Lock Packet No Once saved a lock will appear to the left of 

packet number and the Lock Packet title will 
change to Unlock Packet. To unlock, simply 
click on the Unlock packet selection box 
and save again. This function can also be 
performed from the View Packet List 
Screen by choosing the Set Locks option. 

Users with Budget Operations Security can 
lock packets. 
 

Packet 
Number 

Auto Packet Number is automatically generated 
by the application 
Will show unassigned until saved 

Number appears after the Save action has 
been completed 
 

Status Auto Will remain in Draft status until the packet 
has been released for review by an OFM 
budget analyst for official packets or 
submitted for posting to AFRS for internal 
packets. 

 

 
 Note: It is intended that all agencies, except DSHS, submit one packet for initial Operating and one for 

initial Capital allotments. DSHS must create separate initial operating packets for each program and submit 
all of these packets at the same time. For additional clarification contact the agency’s OFM Budget Analyst. 

Packet Attachments 
 

TALS AMR allows attachments in the Excel, Word, and PDF formats. Documents attached to an allotment 
packet are saved to the TALS AMR database. Attachments added become an artifact of the allotment packet 
and are available for viewing until the packet is deleted. For modifications to documents previously attached, 
update the document on the agency network or workstation, delete and reattach to the allotment packet in 
AMR.  
 
 Note: Unanticipated receipt allotment packets should include the Grant and Award documentation as 

attachments for OFM budget analyst review and approval. 

Important things to know for Attachments!  
• The packet needs to be saved before documents can be attached.  
• Attachment files are limited in size to 3MB. 

Adding Attachments 
 
1. On the Add Packet screen or Update Packet screen, select the Add selection tab, located on the right-

hand side of the screen.  
2. The Add Attachment dialogue box will display. 
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3. Select the Browse button to search for the document to be attached for the allotment packet.
4. After locating the document, double click the file name or single click and click the open button. The

Choose file dialogue box will close upon the selection of the file
5. Verify that the selected attachment name and file location displays in the field to the left of the browse

button.
6. Enter a description of the document.

 Note: The Description field is optional but provides the ability to include a summary of what is being
attached for reference. The description included will display on the View/Add/Update Packet
screens.

7. Select the Attach button. A dialog box will display “File Uploaded!” Click Ok. Close “Add Attachment
Dialog” box by clicking on “cancel” or “X” out of it. The attached file name, file type and description now
display in the attachment section of the screen

8. View the newly added file. Click the attachment selector (circle to the left of the file name), and then select
the View tab.
 Note: The file must be selected prior to clicking the View tab.

9. Click Open Attachment to display the dialog box below. If the “Always ask before opening the type of file”
box is unchecked, the dialog box will not display. The view attachment toolbox will remain open even after
the attachment is closed. To close, “X” out of it.

10. Click Open, view attachment & close the file
11. Click Save

Modifying or Removing Attachments 

If modifications are necessary in the document in the packet, remove the document in the packet (see next 
section), make the modifications on the document then reattach it to the packet. To remove the attachment 
simply click the attachment selector and click Delete. 

Viewing Packet List (View/Update, Delete & Set Packet Locks) 
The View Packet List screen displays a list of the agency’s allotment packets for the selected biennium. 
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 Note: Security access will determine which functions are available. 
 

The Activities Bar: perform actions related to a chosen packet or to add a packet.  
 

 
 

• View Packet: View the packet container information. 
• Add Packet: Add a new packet. 
• Update Packet: Update information in the packet container excluding Biennium, Purpose and Contact. 
• View History: View actions that have been taken on the packet including the action, the user ID, the 

date, and the time. 
• Delete: Delete a packet. 
• Set Locks: Allows budget operations staff to lock and unlock packets. 
• Allotments: Open allotment information of the packet.  
• Import: Import data into the packet. See Importing Text Files and Importing SPS Data for more 

information. 
• Export: Export data out of the packet to change or use in other packets. This information remains in 

the original packet. See Exporting Files for more information. 
• Copy: Copy data from one packet into another packet. See Copy Features for more information. 
• Review Issues: Review issues created by OFM and respond or to create new issues. See Review 

Issues for more information. 
 

Packet Information Table – List of packets and associated details 
 

 
 
• Packet Selection Box: Work with a particular packet or packets. 
• Packet Lock Indicator: Displays a lock symbol when packet lock is set. 
• Packet Attachment Indicator: Displays a paperclip if an attachment has been added to the packet. 
• Traffic Light Indicator: AFRS edit check and submittal process shows the following green, yellow, red 

or no traffic light depending on where the packet is in process.  See Pre-Release Edit Checks for more 
information. 

• Packet Number: A number automatically assigned by the system and is the default sort showing the 
most recent packet first in descending order. Deleted Packet numbers will not be reused. 

• Packet Purpose: Displays what type of packet; operating initial allotment, operating internal 
adjustments, Capital 1st supplemental etc. 

• Packet Title: Displays the chosen title. 
• Packet Status: Shows the current status of the packet; Draft, Pending, Review, Returned, and 

Approved. 
• Packet Program: Displays the program number and title if the allotment is tied to a program 
• Exp: Displays a check mark if allotment packet contains expenditure data. 
• Cash Disb.: Displays a check mark if allotment packet contains cash disbursement data. 
• Cash Recpt.: Displays a check mark if allotment packet contains cash receipt data. 
• Rev.: Displays a check mark if allotment packet contains revenue data. 
• Explanation: Displays a check mark if allotment packet contains agency external comments. 
• Internal Comment:  Displays a check mark if allotment packet contains agency internal comments. 
• Last Update: Displays the user that last edited the packet. Holding the cursor over this field displays 

the date and time of the last edit as well. 
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• Creator: Displays the user that created the packet. 
• Action/Report Selection Drop Down Box & Run Button: Choose certain actions to perform on the 

chosen packet(s) and run reports on chosen packets. See Pre-Release Edit Check for more information 
on action selections (AMR Pre-release Edits, AMR AFRS Edits, Most Recent Edit Report, Submit 
Packet(s) and Recall Packet) and Reports for more information on report selections.  
This includes: 

 
 
• Page Indicator: specifies the current page. The number without the underline is the current page. 
• View Packet List: Navigate to view, add, or update the packet details. Those with read only access will 

only be able to view. Edit access (as long as the packet is unlocked) and budget operations can do all 
three. 
 Note: Each column header has three possible states; not sorted—indicated with no arrow, 

sorted ascending—indicated with an up arrow, sorted descending—indicated with a down 
arrow. These can be selected by clicking the text in the column header. On the View Packet List 
screen, the sort default is Number in descending order. 

Expenditure Allotment Data 
 

After creating a container, the packet, for allotments the next step is to define the program, project, and 
organization coding level detail. This is called the “coding structure.”  
 
 Note: Coding Structures and Allotment Details can be added and updated for any packet in a status of 

draft or returned.  
 

To add, update, delete, or view coding structures for a packet, place a check mark in the packet selection box 
and select the Allotments tab. The Breadcrumb Bar now includes the Allotment Coding Structure. 
 

 
 
The Component Navigation Bar provides the means to switch between the four allotments components 
Expenditures, Cash Disbursements, Cash Receipts and Revenue. The highlighted “tab” indicates the 
component which is currently being viewed and displays all coding structure records established for the 
component. Below, the Expenditures is the selected component.  
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The Activities Bar performs actions related to a chosen coding, this includes Add, Update, Delete, Allotment 
Details, Comments, Pattern* and Copy.  

 

 
 

• Add: add a new coding structure.  
• Update: update a coding structure.  
• Delete: delete a coding structure.  
• Allotment Details: Add, update, and delete the detail related to a chosen coding structure.  
• Comments: Make comments about the entire component; expenditure, cash disbursements, cash 

receipts or revenue.  
 Note: The comment tab within coding structure adds comments referred to in the Pre-Release Edits 

as component level comments.  
• Copy: Copy coding structures. See Copy Features for more information.  
• *Pattern: Create a pattern for cash receipts and cash disbursements.  See Creating the Cash 

Disbursement Allotment Data & Creating the Cash Receipts Allotment Data for more information.  
  Note: * Indicates performance on the Cash Disbursements and the Cash Receipts components 

only 
 Note: The allotment coding structure screen also includes a row selection box to choose how many 

rows of data are visible between 10, 20, 30 or All. To get this to display the number of rows select 
and Load. 

Coding structure: 
 

1. Click Add in the Expenditures tab.  
2. A highlighted selection box appears for program index [Enter or Select a Program Index]  

 Note: This is a required field.  
3. User Defined: This is not a required field however, OFM strongly encourages users to populate this field 

with “Interagency” to indicate Interagency FTEs when appropriate. 
 

 
 



The Allotment System – Allotment Management & Review User Guide (TALS-AMR) 

 

TALS-AMR Revised March 2022 13 of 43 

4. Add a program index. While the “Enter or Select a Program Index” box is highlighted there are options
available to add the program index;
• typing in the index will bring up a series of program indexes
• typing in the whole index or
• the keyboard down arrow will show all program indexes available in the agency, however, if the agency

has a lot of program indexes this ‘…’ will show at the bottom. To get to the codes further down the list
type the beginning of the code and it will populate any matches.

To add additional coding structure, the above actions are available or choose the Add button at the bottom 
of the screen. By clicking the “Add” button the data is saved automatically; however, after the last code 
save the data using the “Save” button. 

5. If allotted at the lower levels (Organization Index, AFRS Project, AFRS Sub Project, AFRS Project Phase,
Budget Unit, Budget Activity, User Defined) the rest of the coding structure operates the same as program
index.
• Project is a hierarchical field, to enter a sub project the project must be entered first
• For a project phase the project and sub project must be added first.

6. To leave the dialog box click cancel or “X” out of it.

Adding Allotment Details 

After the coding structure has been established, the allotment is available to add data for that structure. TALS 
refers to allotment data as Allotment Details. 

1. To add or view allotment details for a coding structure, an existing coding structure must exist and only one
coding structure can be selected at a time:
• Place a check mark in the coding structure selection box
• Select the Allot. Details tab

The allotment details screen is returned 
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 Note: Hide or expand grid details by selecting the ‘+’ plus symbol to the left of the grid title, the grid 
expands for adding or viewing details. The ‘-’ negative symbol to the left of the grid title collapses the grid. 
By default, the only grid expanded on entry of a coding structure with no allotment details is Expenditure 
Allotment Details.  

 Note: The allotment coding structure screen also includes a row selection box to choose how many rows of 
data to view;  10, 20, 30 or All. To change the display the number of rows, select the preference, and Load.  

 

Adding Allotment Detail - Option 1 Agencies 
Option 2 agencies please skip steps 1 through 6. 

Option 1 agencies are required to enter both an Expenditure Authority Index and an Object when adding 
allotment detail, these two required fields are entered as separate allotment detail records within the same 
coding structure.  
 
1. To add expenditure allotment detail, click the Add tab 

within the allotment details.  
 The following dialog box appears:  
 
2. Choose an Expenditure Authority Index (EAI), which is 

also referred to as Appropriation Index (AI). Options for 
choosing the AI  
• The Keyboard down arrow or 
• Type in the EAI 

3. The Object, Sub-Object, and Sub Sub-Object will be 
disabled. Enter fiscal year dollar amounts by month 
and save.  
 Note: The EAI determines what fiscal period dollar amounts will be available. For example, if a first 

year EAI is selected, the second-year dollar amounts will be disabled and not available for input.  
 Note: For records that have an EAI that cannot be found in the statewide tables, the fiscal period is 

assumed to be Biennial.  
4. Click Add, and then choose an Object and Sub Object, which EAI will be disabled. Enter fiscal year 

dollar amounts by month and save.  
5. Add further allotment details using the Add selection box and following step 3.  
6. Exit the dialog box by hitting cancel or “X” 
 Note: When there is a variance, the variance is displayed in the expenditure grid under variance. 

Variance displays the difference between the sum of the objects and the sum of the appropriation 
indexes for each month. See below.  
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 Note: The Expenditure Allotment Details screen also includes a row selection box to choose how many 
rows of data to view 10, 20, 30 or All rows. To display the number of rows, select preference, and 
Load.  

Adding Allotment Detail - Option 2 Agencies 
Option 1 agencies please skip steps 7 through 11. 

 
Option 2 agencies are required to enter both an Expenditure Authority Index (EAI) and an Object from the Add 
Expenditure Allotment Detail screen.  

3. To add expenditure allotment detail, click the Add tab within the allotment details. The following dialog box 
appears: 

 
 
4. Choose an EAI (Expenditure Authority Index is also referred to as Appropriation Index Or AI) by using the 

down arrow or typing in the EAI.  
5. Select an object, fiscal year dollar amounts by month and save.  
 Note: Expenditure Authority Index and Object are required allotment detail fields these two required 

fields are entered together in one allotment detail as depicted below.  
 Note: The EAI determines what fiscal period dollar amounts will be available. For example, if a first 

year EAI is selected, the second-year dollar amounts will be disabled and not available for input.  
 Note: For records that have an EAI that cannot be found in the statewide tables, the fiscal period is 

assumed to be Biennial.  
6.  Add further allotment details by clicking the Add selection box and following step 9. The allotment detail 

should equal the EA schedule when complete.  
 Note: For option 2 agencies: If all details aren’t displayed, the first row “Total” will be a sub-total of all 

the amounts displayed in the grid. The second row, Grand Total, will be a total of all the amounts if 
multiple pages of data exist. In the image below the Grand Total is the total of all the amounts on page 
1 and 2.   

7. Exit the dialog box by hitting cancel or “X”.  
 Note: The Expenditure Allotment Details screen also includes a row selection box to choose how many 

rows of data to view 10, 20, 30 or All rows. To display the number of rows, select preference, and 
Load.  
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Adjustment Amount 
 

The adjustment amount field is available only for Operating Quarterly Adjustments, Operating Internal, and 
Capital Internal packets. The adjustment amount field was created to allow agencies to move allotment 
capacity from closed fiscal months without skewing the current month or changing the official allotment record 
for closed months. The total adjustment from closed months can be placed into the adjustment month field and 
the current month amount will contain the actual change desired for that month. The adjustment amount will 
show as a separate entry on the TALS-AMR reports. The adjustment amount will however be posted to AFRS 
in the current fiscal month.  

 
1. Create a new packet with packet purpose  
2. Add a new coding structure and allotment details. Notice that a new amount tab is available (Adj. Amount).  
 

 

3. After choosing an EAI and Object put a negative dollar amount in Adj. Amount and spread that amount in 
open months, then click Save and Cancel.  
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Moving Unallotted Funds into Allotted 
 

1. Create a quarterly adjustment packet.  
2. Expand the Unallotted Allotment Details grid, choose the Add tab, choose an EAI, then put in a negative 

dollar amount, click Save and Cancel.  
3. Now take that amount and allot it in open months.  
4. Expand the Expenditure Allotment Details grid, click the Add tab and choose an EAI and Object, and 

put the amount in and click Save and Cancel. 

 
 

Update Expenditure Allotment Detail 
Option 1 and Option 2 agencies: 

Within Allotment Details for allotted Expenditures, FTEs, cash disbursements, cash receipts, and revenue 
there are several choices on how to enter the dollar amounts. It is always recommended to choose the EAI first 
to determine which dollar fields should be available to enter into. The dollar amounts can be manually entered, 
pasted from an excel spreadsheet, one amount to repeated over the fiscal period, one amount spread over the 
fiscal period, or one amount spread quarterly over the fiscal period. Instructions for each process is listed 
below in steps 1 – 5.   

1. Add allotment detail dollar amounts using the manual process.  
• Use the tab and enter keys 
• Highlight the dollar amount, Ctrl “C” for copy and Ctrl “V” to paste into the next dollar amount area 

2. Add allotment detail dollar amounts using the paste function.  
• Choose dollar amounts from an excel spreadsheet by highlighting the rows, select either an edit/copy 

or Ctrl C, and paste or Ctrl “V” in the fiscal month.  
 Note: pasting up to 24-dollar amounts is allowed, however, if there are more amounts than there 

are months it will only paste the first 24 if it’s a biennial EAI, or 12 if it’s a fiscal year EAI. The 
correct beginning month should be selected carefully when pasting dollar amounts.  

3. Add allotment detail dollar amounts using the repeat function. 
• Choose which month to start, enter the amount to repeat, and select the repeat button.  

4. Add allotment detail dollar amounts using the spread function.  
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• Choose which month to start and then enter the amount to spread over the fiscal period. If necessary, it 
will round the last month of the fiscal period to equal the total amount selected to spread.  

5. Add allotment detail dollar amounts using the quarterly function.  
• Choose which month to start and then enter the amount to spread quarterly over the fiscal period. If 

necessary, it will round the last month of the fiscal period to equal the total amount selected to spread. 
If this function is used after using the other functions, it will only replace the quarterly amounts.  
 

 
 

 Note: Fiscal month fields are available for input based on the EA code used to establish the expenditure 
authority index. When updating, if dollars exist in fiscal months not consistent with the fiscal period control 
of the EA code, a Roll amounts button will be available. 

 Note: To remove dollar amounts from the read-only fiscal months, select a new expenditure authority index 
(consistent with the entry fiscal months) or select the Roll Amounts button.  

 Note: The Roll Amounts button will move dollar amounts to their corresponding fiscal month amount for the 
fiscal year control of the EAI. (For example: an EAI with a Fiscal Year 2 control, Fiscal Month 1 dollars are 
moved to Fiscal Month 13. 

Adding FTE, Unallotted and Reserve Allotment Detail 
 

1. Adding Allotments, choose an existing coding structure by clicking the coding structure selection box or 
create a new structure, then click the Allot. Details tab 

2. Expand Staff Month Allotment Details and Add 
• Choose an Account and enter FTEs by month. Save and Cancel. Please select FTEs as Interagency 

FTEs for tracking purposes  
 Note: If Account is selected, the EAI will not be available. If EAI is selected, the account will 

automatically fill in. OFM only requires that FTEs be by GF-S 001 account or 996 for all other; 
however, indication of specific accounts detail is supported 

 Note: The Transportation FTE box will automatically flag if the Account chosen is associated 
with a transportation Account.  

1. Expand the Unallotted Allotment Details grid by clicking the ‘+” sign, and then click Add.  
2. Add a fiscal year one EAI and Fiscal Period Amt., click Add  
3. Add a fiscal year two EAI and amount and click Save and Cancel.  

 
Follow steps 1-3 to add information into Reserve Allotment Details.  
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Cash Disbursement Coding Structure and Allotment Detail 
 

Agency allotments must include monthly estimates of the cash they will disburse by account. As an agency 
prepares initial or adjusted expenditure allotments, they almost always will need to include an allotment for the 
related cash disbursements.   

 Note: Coding structure is optional for cash disbursements allotments; however, the account must be 
identified as part of the allotment detail. A blank coding structure would imply that the cash disbursement is 
allotted at the agency level. 

 
1. From the View Packet List Screen, choose a packet, and click the Allotments tab. 
2. On the component navigation bar, select Cash Disbursements. 
3. Select a blank coding structure check box  
4. Click the Allot. Details tab, this will bring up the cash disbursements allotment detail grid 
5. Click the Add tab The Add tab will return the Add Cash Disbursements Allotment Detail dialog box 

 

 

6. Choose an Account and enter dollar figures. 
 Note: EAI is an optional field, the Account will 

automatically be entered if an EAI is chosen.  
7. Click Save and Exit the dialog box 

 

 

 

 

Patterning Cash Disbursements 
 

A patterning tool is available for creating Cash Disbursement and Cash Receipt Allotment detail for the initial 
allotment. Patterning is available to easily create an allotment based on the pattern of actuals from the 
previous biennium. Prior to Patterning cash disbursements, please review the following guidelines:  

• Patterning is performed at the account level.  
• The pattern takes the dollar amount entered for the account and prorates it monthly based on the 

previous biennium’s actuals or allotments.  
• If all months of the biennium are not final the pattern will use the allotment for those months. 
• A pattern will only be created for accounts that have amounts entered. If the amount is left blank it is 

considered to be zero and no pattern will be created for that account. It will replace any data previously 
in that account with a zero.  

• A pattern cannot be created on an account that did not exist the prior biennium.  
• A pattern can only be performed using a blank coding structure. 
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1. In the Allotment Coding Structures and select a blank coding structure or create one by doing an Add, 
then Save without entering any information. 

2. Select the Pattern tab. 
 

 
 

3. The Patterning Dialog Box will open (Right) 
 

4. Add in the total amount needed to pattern for the account codes to 
pattern. Then click Save.  

5. The following warning will be displayed: 
 

 
 Note: This message does not mean that it will delete account 

data already created in other coding structures. Be aware of 
not duplicating cash 

6. Click OK, confirmation will be displayed, Click OK again 
 

 
7. To view the allotment detail created from using patterns click on the blank coding structure selection box, 

then Allotment Details. 

Cash Disbursement Coding Structure and Allotment Detail 
 

Agency allotments must include monthly estimates of cash projection by account. As an agency prepares initial 
or adjusted revenue allotments, most will need to include an allotment for related cash receipts. 

 Note: Coding structure is optional for cash receipts allotments, however the account must be identified as 
part of the allotment detail. A blank coding structure would imply that the cash receipt is allotted at the 
agency level.  

 Note: The Account is a required field while major source and source are optional fields for cash receipt 
allotments.  

1. In View Packet List choose a packet and select the Allotments tab 
2. On the component navigation bar select Cash Receipts.  
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3. Select a blank coding structure check box and click the Allot. Details tab, this will bring up the cash 
receipts allotment detail grid 

4. Choose an Account and enter dollar amounts.  
5. Click Save and exit the dialog box.  

 
Patterning Cash Receipts 

 
A patterning tool is available for creating Cash Disbursement and Cash Receipt Allotment detail in the initial 
packet only. Patterning is available to easily create an allotment based on the pattern of actuals from the 
previous biennium. Prior to Patterning cash disbursements, please review the following guidelines:  

• Patterning is performed at the account level.  
• The pattern takes the dollar amount entered for the account and prorates it monthly based on the 

previous biennium’s actuals or allotments.  
• If all months of the biennium are not final the pattern will use the allotment for those months. 
• A pattern will only be created for accounts that have amounts entered. If the amount is left blank it is 

considered to be zero and no pattern will be created for that account. It will replace any data previously 
in that account with a zero.  

• A pattern cannot be created on an account that did not exist the prior biennium.  
• A pattern can only be performed using a blank coding structure. 

 
1. Go to the Allotment Coding Structure and select a blank coding structure or create one by doing an Add, 

then Save without entering any information.  
2. Then select the Pattern tab as was done in the cash disbursements exercise, the Patterning Dialog box is 

displayed. 
3. Add in the total amount needed to pattern for the various account codes to pattern. Then click Save.  
4. The following warning will appear.  

 

 Note: This message does not mean that it will delete account data already created in other coding 
structures. Be aware not to duplicate the cash receipts by creating coding structures with the same 
accounts used in patterning.  

5. Click OK, confirmation will be displayed, Click OK again. 
6. To view the allotment detail created from using patterns click on the blank coding structure selection box, 

then Allot. Details.  

Unanticipated Receipt (UAR) 
 

 The unanticipated receipt (UAR) packet requires the use of the unanticipated receipt form from within the 
application. This keeps all documentation of the UAR in one location.  

1. Create an unanticipated receipt packet by choosing the Biennium, Purpose “Operating Unanticipated 
Receipts” and choosing a contact. After Save a new tab is available called “UAR.”  
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2. Click on the UAR tab to the Unanticipated Receipt Approval Request form.  
3. The form has specific information to be completed, the requests on the form are as follows:  

• Packet Number: Derived from the packet and will also display the packet title.  
• Date Submitted: Automatically fill in once the packet is submitted with that date.  
• Agency Code & Title: Derived from the packet.  
• Contact Person: Required field.  
• Phone Number: Required field for the contact person’s phone number.  
• Program Code & Title: Drop down field the user can choose for the appropriate program. It is an 

optional field.  
• Budget Activity Code & Title: Optional 
• Operating/Capital: Derived from the packet type.  
• Purpose of Grant and Description of how the funds will be used: Please see information below.   
• Time Period for this Grant Award: Beginning and end dates are two required date fields.  
• Type of Grant/Award: One of the following options is required   

o new 
o renewal 
o addendum or  
o carry over from the previous biennium (the previous packet number must be indicated)  

• Pass-Through Only: Optional check box. If selected, an explanation must be given.  
• Budget Impact Summary: Captures FTEs, grant and/or award, and matching fund information for 

previous, current, and ensuing biennia. The current allotment request and the amount the agency 
expects to request in the next budget submittal is required as well.   
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 Account EA 
Type 

Previous 
Biennium 

Current 
Biennium 

Ensuing 
Biennium 

Current 
Allotment 
Request 

Amount 
Agency 
Expects 
to 
Request 
in Next 
Budget 
Submitta  

FTEs -- -- FTE Amount 
(O) 

FTE Amount 
(O) 

FTE Amount 
(O) 

FTE Amount 
(O) 

FTE Amoun  
(O) 

Grant/Award Derived 
From 
Packet 

Derived 
From 
Packet 

Dollar 
Amount(O) 

Dollar 
Amount (R) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Matching 
Funds 

Drop 
Down (O) 

Drop 
Down 
(O) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Dollar 
Amount(O) 

Total 
Dollars 

-- -- Calculated 
Sum of 
dollar 
amounts 
above 

Calculated 
Sum of 
dollar 
amounts 
above 

Calculated 
Sum of 
dollar 
amounts 
above 

Calculated 
Sum of 
dollar 
amounts 
above 

Calculated 
Sum of 
dollar 
amounts 
above 

(R) – Required (O) - Optional 

• Does the Grant Require Matching Funds? if yes: indicate the source of matching funds and 
programs and activities that will be affected by using these funds.  

• Analysis section 
o Can these funds be substituted for presently allotted funds? If yes: at least one matching 

reserve allotment detail record must exist in the packet before it can be submitted. If no: and 
the reason is anything other than a specific stipulation by the grantor, it must be explained. In 
the second question 

o Does acceptance of these funds commit the state to further expenditures in a later period? If 
yes: the probable source of future funding must be explained.  

o Does this new grant/award create a new policy direction? If yes: it should be considered in the 
agency’s new budget request rather than the unanticipated receipt process.  

4. Fill in the following then click Ok  
5. Click on the Allotments tab and set up a coding structure and allotment detail for the $10,000 award.  

 
 Note: When establishing an UAR set up an Appropriation Index through the AFRS tables as described in 

the Allotment Instructions and the State Administrative and Accounting Manual (SAAM). At least one 
having an appropriation type of a 3 or 9. This information must be in the AFRS tables before the submittal 
of the UAR, if this is not completed it will not pass the pre-release edits. 

 
 Note: For capital UAR packets, established coding in AFRS is required prior to creating the allotment so 

the capital project number can be edited in the system. 
  
 Note: All UAR packets must include an attachment of the grant award.  

 
Revenue Allotment Data 

 
The Revenue coding structure is optional for revenue allotments; however, the account, major source, and 
source levels must be identified as part of the allotment detail. A blank coding structure means the revenue is 
allotted at the agency level. 

1. In View Packet List select a packet and the Allotments tab. 
2. On the component navigation bar select Revenue. 
3. Select a blank coding structure check box and click the Allot. Details tab.  
4. Select the Add tab, the Add Revenue Allotment Detail Dialog Box will then be displayed 
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5. Choose an Account, Major Source and Source and enter dollar amounts.  
 Note: EAI is an optional field for revenue allotments. Account, major source, and source are required 

components. 
 Note: Major source is a hierarchical field, to enter a source a major source must be entered first or to enter 

sub source, both major source and source must be entered first.  

6. Click Save and exit the dialog box.  

Copying A Packet 
 

To copy a packet is to copy the coding structures and allotment details contained in one packet to another 
packet. Packets can be copied in full, or parts may be selected to copy. Please note that copying information 
from any packet is an option but copying into a packet is allowed only when the packet is in draft status.  
 

1. In View Packet List select a packet and the Copy tab. 
 

 
 

2. The copy tab has the following options:  
• Include: Include all components or deselect components not needed. 
• Detail Options: A descript list for Detail Options is as follows: 

o Include Details: Includes allotment details and amounts.  
o Include Details/Reverse Signs: Includes allotment details and changes all positive amounts to 

negative and all negative amounts to positive.  
o Include Details/Zero Out: Includes coding structure and allotment details with no amounts.  
o Do Not Include Details: Copies only the coding structures.  

• Merge/Sum Amounts Together for Duplicates: this action adds coding structures that do not exist in 
the ‘to’ packet and when there are duplicate coding structures the amounts are added together. 

• Delete Original/Replace: this deletes everything in the ‘to’ packet and brings in the selected items. 
• To Packet: Select the Packet to copy information into.  

• Biennium – use the dropdown arrow to select the biennium for the ‘to packet’.  
• Packet Purpose (Optional):  use the dropdown arrow to select the packet purpose to reduce 

the packets to choose from for the ‘to packet’.  
• Packet – use the dropdown arrow to select the packet to copy into.  

 
3. Once selections are made click the Copy button and a message will appear warning of the action that will 

be taken. 
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4. If this is intended, click the OK button. 

 

5. A message will appear saying that the action was completed. 

 Note: To merge multiple packets and reverse the signs;  
• Select the multiple packets to merge 
• Merge the selected packets into one packet 
• Create a new packet,  
• Copy the merged packet into the new packet and reverse the signs. 

 

Copying the Coding Structure 
 

Copy coding structure is to copy the selected coding structure contained in one packet to another coding 
structure within the same packet. The coding structure can be copied with or without the allotment details, 
however, only one coding structure can be copied at one time.  

a. From View Packet List select a packet and the Allotments tab.  
b. Select the coding structure to copy and the Copy tab. 
c. The copy tab has the following options:  

• Include: Include all components or deselect components not needed. 
• Merge/Sum Amounts Together for Duplicates: Adds allotment details that do not exist in the ‘to’ 

packet and when there are duplicate coding structures the amounts are added together. 
• Delete Original/Replace: Deletes everything in the ‘to’ packet coding structure and only brings in the 

selected items. 
• To Packet: Select the coding structure to copy information into. 

o New Coding Structure – use the dropdown arrow to select a new coding structure.  
o Existing Coding Structures – use the dropdown arrow to select the coding structure to copy 

to.  
 Note: Biennium, Packet Purpose, and Packet are not applicable at this time and are grayed out.  

4. Once the selections are made, click the Copy button.  
• If the existing coding structure was selected, an alert will appear to confirm the action that will be taken. 

If this is the intended action, click the OK button. 
• If the New Coding Structure was selected an alert will appear to show the coding structure being 

copying from. Enter the new coding structure and click Save.  
5. The next message will state the action is completed.   

Exporting Files 
 

Agencies may want to make changes to an existing allotment packet. The Export tool can be used to export 
allotment data, make modifications, and then import back into TALS-AMR. The following are tips for exporting:  

• Only one packet can be exported at a time  
• The allotment data will be exported into a tab delimited text file.  
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• If modifications are needed, it is recommended to save the export text file into Excel, make changes, 
save it back into a tab delimited text file and then import back into TALS-AMR. 

 
Export/Import Coding Structure & Allotment Data 

 
1. From the View Packet screen, select the allotment packet to export and the Export tab. Select an allotment 

packet that has allotment data. The Export Data dialog box will be displayed.  
2. All data elements are selected by default when the Export Data dialog box opens. Select the Export 

button.  
 

 
 

 Note: Deselect the appropriate selections by clicking the check boxes. 
3. Save the file  
4. Confirm the save location of the export file. To make modifications to exported allotments make the 

changes in Excel via one of the following options:   
• Open the exported text file, copy, and paste into the Excel Import Template.  
• Open Excel, change “Files of type” to Text Files, browse until the exported text file is located, and 

double click on the text file. To modify the text file, make changes in an Excel file rather than in the 
text file so the  columns line up with the headings  

5. Download Complete dialog box will be displayed. Select Close.  
6. The Text Import Wizard dialog box will open.  

• Step 1  
o “Delimited” data type 
o “Next” 

• Step 2  
o “Tab” 
o “Next” 

• Step 3 of 3 
o Highlight all of the coding columns (hold the shift key down) do not highlight the 

Amounts columns 
o “Text”  
o Finish  

7. The exported text file will open in Excel however, the file extension is .txt. After the file is open, highlight 
the coding columns, select Format, select Cells, select Text and then select OK. The coding columns are 
formatted to text ensuring the codes with leading zeros will not be lost. 

 Note: Excel Tip:  Freeze the column headings by clicking View > Freeze Panes > Freeze 
Top Row 

8. Add a row of coding for the agency with amounts for each of the following allotment types:  
• Expenditure = EXP 
• FTE, Reserve = FTE 
• Unallotted = UNA 
• Revenue = REV 
• Cash Disbursement = CAD 
• Cash Receipt = CAR 
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 Note: Option 1 agencies must have a separate row for expenditure EA Indexes and 
Objects. 

 Note: Allotment Type Code for the following: (see appendix 3 for the Import Specification)  
9. Save this file as a text, tab delimited file 

• Select File, Save As, (location) 
• Change the File Name: Agency XXX Export X.txt  
• Save as Type: Text (Tab delimited) (*.txt)  
• Select Save 
• At the prompts click OK then Yes 

10. The text file has been saved.  

Importing Text Files 
 
The Import tool gives agencies the ability to import data from an agency internal allotment system or from 
Excel spreadsheets when the template format is used. The Excel template is a download needed to import 
allotment data into the application.  
• The template format is in the required Import format. Do not add, delete, or rearrange columns. 
• It will be the agency’s responsibility to ensure that the import file is in the proper format and the fields 

within the file meet the prescribed format (see appendix 3 for the Import Specification). 
 

1. From the View Packet screen, add a new packet. In the packet title enter: Import Packet  
2. Select the new packet and then select the Import tab. The Import dialog box will display. 
3. Select the link or Click here to download the file upload template.  A File Download dialog box will be 

displayed. 
4. Select Open and the AMR Import template will open.  
5. Select Save As and save this template as an Excel file.  

 
The import template is now ready to create allotments to import into TALS-AMR.  
 
Import Text File Notes:  
• The packet into which the data will be imported must exist prior to selecting the Import tab.  
• Data can be imported into a draft packet or returned status only.  
• Ability to merge a text file into an existing packet that already has data. 

o When the Merge/Sum Amounts Together for Duplicates radio button is selected, the import will 
merge all new coding structure and allotment detail data, for all components. When there are 
duplicate coding structures and allotment details, the amounts will be summed together.  

o When the Delete Original/Replace radio button is selected, the import will replace all Coding 
Structure and Allotment Detail data for all components.  

• If there are import errors, the text file will not import into the application.  
• Imported files cannot be larger than 3MB.  
• An import for both the SPS Import and the text file import, import the text file first then the SPS Import. 

The import should be performed in this order is because the Import Text File replaces or merges all 
data. The SPS Import only replaces or merges FTE, and expenditure object A and B data. See the 
Import SPS Data lesson for more information.  

 
1. From the View Packet List, select the allotment packet to import into. Then select the Import tab.  
2. Select the Text File tab. 

 
 

3. Select the Browse button, search for the text file updated in the prior lesson. To import, double click the 
file for import. A tab delimited text file type is required. 

https://qa-talsamr.ofm.wa.gov/Import/ImportTextFileTemplate.xls
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4. After selecting the File, the File location and name will appear to the left of the Browse button on the Import 
dialogue box. Select the Delete Original/Replace radio button.  
 

 
 

• By selecting the Merge/Sum Amounts Together for Duplicates, it will merge all new data and sum 
duplicate data amounts together but will not delete data previously in the packet before the import. This 
functionality would be used to merge a text file into a packet that already has data. 

• By selecting the Delete Original/Replace radio button, this import will delete and replace all data in the 
selected packet.  

 
5. Select the Upload Button. The system will display a warning message about deleting existing data, click 

OK.  
6. On completion of the Text File Import, the system will display a successful message, click OK.  

 
 Note: For an unsuccessful import a Text Import Error Report will be sent. The errors must be corrected 

before the import will upload successfully. It is recommended make corrections in Excel rather than in the 
text file. 

Importing SPS Data 
 

Agencies can create SPS Projection files that can be used to import allotment data for FTEs and expenditures 
for objects A and B. 

• The packet into which the data will be imported must exist prior to selecting the import tab.  
• Data can be imported into any packet in a status of draft or returned.  
• An SPS Projection file can be imported into a packet that has existing data.  

o When the Merge/Sum Amounts Together for Duplicates radio button is selected, this import will 
merge any new data into the selected packet for FTEs and expenditure objects A and B only. If 
there is duplicate data with the same coding structure and allotment detail for FTEs and 
expenditure objects A and B, the amounts will be summed together.  

o When the Delete Original/Replace radio button is selected, this import will delete and replace 
any data in the selected packet for FTEs and expenditure objects A and B only. If importing both 
the Text File and SPS Data, import the Text File first and then the SPS Data.  

• For Option 1 agencies, allotment details with an EA index will not be deleted but will have their EA 
index amounts added to any new amounts from SPS.  

 
1. From the View Packet List screen, select the allotment packet, then the Import tab.  
2. Select the SPS Data tab. 
3. Click the down arrow for the Projection File. Select the Projection File to be imported. The Projection File 

list only includes projection files for the specific biennium of the selected packet. 
 Note: Both program index and EA index must exist in the SPS Projection File for the SPS data to be 

imported into TALS-AMR. 
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4. Click the down arrow for Salary & Benefit Rollup to select the level of detail to be imported. The Salary & 

Benefit Rollup is referring to Expenditure Allotment Details EAI and not FTE 
5. Click the down arrow for FTE Account Rollup to select the FTE detail level at account or EAI.  

• By selecting Account, the FTEs will be imported by account.  
• By selecting EAI, the FTEs will be imported by EAI.  

6. Click the down arrow for FTE Object Rollup to select the FTE object level.  
• By selecting No Object, FTEs will be imported with no object  
• By selecting Object, FTEs will be imported at the object level  
• By selecting Sub-Object, FTEs will be imported at the sub-object level  
• By selecting Sub Sub-Object, FTEs will be imported at the sub sub-object level 

7. Select the Delete Original/Replace radio button.  
8. Select the Import button, the system will display a warning message, click OK  
9. On completion of the SPS import, the system will display a successful message, click OK.  

 Note: Option 2 agencies will receive the following message, select OK.  
 

 
 

 Note: Option 1 agencies will receive the following message, select OK.  
 

 

Online Views 
 

Online Views is available to view allotment data for analytical purposes. Online Views enables a user to specify 
the specific data to view by way of creating a query—called a “filter” in the system.  

Once the filters have been created it can be organized in different hierarchy choices. This is done by the 
grouping level selected in the filter tab. There are 4 grouping levels, 1 grouping level must be selected.  
 
To quickly view the amounts requested at a summary level as well as the detailed data contributing to that 
summary. By grouping and displaying the user can drill down to the data as needed from the filter.  
 
Online Views are not intended for printing, however, can be exported by clicking Export Data. Data will 
export in XML format and will include only Group Level 1 data. For optimal printing of allotment data, use 
the AMR reports through Enterprise Reporting.  
 
Online Views behaves differently depending on the Option of the agency.  
 

The filter contains 4 tabs:  
• Packet – choice of components for expenditures, cash disbursements, cash receipts, and revenue 

information. Contains selections for packet number, purpose, status, packet program, and title.  
• Organization – contains coding structure information for program, organization, and project  
• Account – contains expenditure authority, account, and object choices  
• Summary – lists the filter summary  

 
Online Views for OPTION 1 Agencies 

Option 2 Agencies are in the next section 
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Since an option 1 agency enters expenditure data by Object and EAI separately, they need to view the data 
separately as well.  

 Note: If no criteria are selected for either Object or EAI on the Account tab, Expenditures by Account or 
EAI will display by default. If Object criteria are selected on the account tab, but no EAI criteria, then 
only the Expenditures by Object will display. If both Object and EAI criteria (leave the EAI Criteria field 
blank, however, select Group Lvl. and check Disp.) are selected on the account tab then both grids will 
be displayed 
 

Below seeing a sample online view for Program, Account, EAI, and object detail in 3 packets for an Option 1 
agency. Following will be the steps show how to create this display. Group level 1 is Packet Number, group 
level 2 is Program, group level 3 is Account, and group level 4 is EAI and Object, and displaying packet 
number, program, account, EAI, and object. 
 

 

Creating the Online View 
 

1. Select the Online Views option from the application tab bar, next to the View Packet List button.  
2. The ‘No’ filter has been defined for the Online View’ message will prompt to create a filter.  
3. Select the Filter tab, the Allotment Review Filter will be displayed. The Filter tab specifies the data and 

level of detail viewed and how that data should be displayed on the screen. The filter contains 4 tabs:  
• Packet: choice of expenditure, cash disbursement, cash receipt, and revenue component information. 

Contains selections for packet number, purpose, status, program, and title. Also, the choice of viewing 
expenditures, staff months, unallotted, and reserves within the expenditure’s components.  

• Organization: contains coding structure information for program, organization, and project 
• Account: contains expenditure authority, account, and object choices 
• Summary: lists the filter summary 

4. From the Packet tab first select the Expenditures Component. 
5. When Expenditures is selected select to display Expenditures, Staff months, Unallotted and Reserves. For 

this example, the Expenditures is selected. 
• Any one or all may be selected.  
• Grouping and Displaying data: Create hierarchies of data by selecting to display elements at a 

particular group level by using the Group Lvl. combo box. Up to 4 group levels may be selected. Each 
group level is displayed in the online view as a summary row with a “+” to expand the rows that 
contribute to that rollup. If the element is to be displayed in the online view the Disp. box must be 
checked. Specify criteria to filter or leave it blank to return all data.  

• A Group Lvl. must be chosen if a criterion is entered. 
• At least one element must be selected to display. 
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6. Select Group Lvl 1 and check Display for packet number and enter three packet numbers in the Criteria 
box.  
• A filter can define the criteria to view. The Criteria may be entered manually into the criteria box or click 

on the “…” for a list and make the selections from the list. Criteria can be entered up to 255 characters. 
If the criteria box is blank all data will be returned. 
 

 
 
7. From the Organization tab, select Group Lvl 2 for Program and check display Program.  

• Select the ‘-’ to close expandable fields for Program, Org. and Project. 
• The criteria for these coding elements are entered in the text box next to its associated coding level, or 

can be selected from the lookup dialog. Enter a single criterion or multiple criteria elements by 
separating them with a comma.  

• Click on the ‘…’ at the right of the text box for the lookup dialog. 
8. From the Account tab select to group and display the Account (Group Lvl 3), EAI, and Object (Group 

Lvl 4). As stated above for Option 1 agencies, in order for both EAI and Object to appear in online views, 
select to display both.  

9. The Summary tab will display the filter criteria selected after the Refresh button has been pressed. 
10. When the selections have been made, press the OK button. 
11. The data can now be expanded and collapsed as needed. Expand where there is a ‘+’ and collapse where 

there is a ‘-‘. When the data has been expanded, it will remain expanded throughout the session, as long 
as a new filter is not created. If the Expand Rows tab is selected; this will expand all rows down to the 
magnifying glass. To collapse all rows, select the Collapse Rows tab.  

12. Updating data from Online Views – the magnifying glass icon indicates the lowest grouping level of data 
has been reached. When the magnifying glass has been clicked, go to the Packet, Coding Structure and 
Allotment Detail information to select an item to update or delete. The Coding Structure and Allotment 
Detail rows will have check boxes to allow the selection of those records to open for updating, or for 
deleting. 
• When delete is selected a confirmation dialog box will appear.  

13. When updating a record, the dialog box appears with the data as originally entered, make any changes, 
and Save.  
• After saving, the dialog box will reappear with the update. Click cancel to close the dialog box. It will 

return to the previously expanded Online View. If one of the sort criteria is a change as an update or 
delete, the filter will re-run and may not display any information.  

14. When finished with this view and would like to select a new filter just click the Filter tab. The previous filter 
will be populated as previously defined. Modify the filter or click Clear to start over.  
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Online Views for OPTION 2 Agency 

Option 1 agencies, skip to the Option 1 agency section 
 

Below is a sample online view for Program, Account, EAI, and object detail in 3 packets for an Option 2 
agency. Following will be the steps that show how to create this display. Group level 1 is Packet Number, 
group level 2 is Program, group level 3 is Account, and group level 4 is EAI and Object. This will display packet 
number, program, account, EAI, and object.  
 

 

Creating the Online View 
 

1. Select the Online Views option from the application tab bar, next to the View Packet List button.  
2. The ‘No filter has been defined for the Online View’ message will prompt to create a filter.  
3. Select the Filter tab, the Allotment Review Filter dialog box will be displayed. It will specify the data and 

level of detail to view and how that data should be displayed on the screen. The filter contains 4 tabs:  
• Packet: choice of expenditure, cash disbursement, cash receipt, and revenue component information. 

Contains selections for packet number, purpose, status, program, and title. There is also the choice of 
viewing expenditures, staff months, unallotted, and reserves within the expenditure components.  

• Organization: contains coding structure information for program, organization, and project 
• Account:  contains expenditure authority, account, and object choices 
• Summary: lists the filter summary 

4. From the Packet tab first select the Expenditure Components. 
5. When the Expenditures are selected, select to display Expenditures, Staff months, Unallotted and 

Reserves. For this example, the Expenditures are selected  
• Any one or all may be selected.  
• Grouping and Displaying data: Create hierarchies of data by selecting to display elements at a 

particular group level by using the Group Lvl. combo box. Up to 4 group levels may be selected. Each 
group level is displayed in the online view as a summary row with a “+” to expand the rows that 
contribute to that rollup. If the element is to be displayed in the online view the Disp. box must be 
checked. Specify criteria to filter or leave it blank to return all data.  

• A Group Lvl. must be chosen if a criterion is entered. 
• At least one element must be selected to display. 

6. Select Group Lvl 1 and check Display for packet number and enter three packet numbers in the Criteria 
box.  
• A filter can define the criteria to view. The Criteria may be entered manually into the criteria box or click 

on the “…” for a list and make the selections from the list. Criteria can be entered up to 255 characters. 
If the criteria box is blank all data will be returned. 
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7. From the Organization tab, select the ‘+’ next to Program, select Group Lvl 2 and check display 
Program.  
• Select the ‘-’ to close expandable fields for Program, Org., and Project.  
• The criteria for these coding elements are entered in the text box next to its associated coding level or 

can be selected from the lookup dialog. Enter a single criterion or multiple criteria elements by 
separating them with a comma.  

• Click on the ‘…’ at the right of the text box for the lookup dialog. 
8. From the Account tab select to group and display the Account (Group Lvl 3), EAI, and Object (Group 

Lvl 4).  
9. The Summary tab will display the filter criteria selected after the Refresh button has been pressed.  
10. When all of the selections have been made, press the OK button. 
11. The data can now be expanded and collapsed as needed. Expand where there is a ‘+’ and collapse where 

there is a ‘-‘. When the data has been expanded, it will remain expanded throughout the session, as long 
as a new filter is not created. There is also an option to select the Expand Rows tab; this will expand all 
rows down to the magnifying glass. To collapse all rows, select the Collapse Rows tab.  

12. Updating data from Online Views – the magnifying glass icon indicates the lowest grouping level of data 
has been reached. When the magnifying glass has been clicked, it will go to the Packet, Coding Structure 
and Allotment Detail information to select an item to update or delete. The Coding Structure and Allotment 
Detail rows will have check boxes to allow the selection of those records to open for updating, or for 
deleting. 
• When delete is selected a confirmation dialog box will appear.  

13. When updating a record, the dialog box appears with the data as originally entered, make any changes and 
Save.  
• After saving, the dialog box will reappear with the update. Click cancel to close the dialog box. which 

will return to the previously expanded Online View. If one of the sort criteria is something changed as 
an update or delete, the filter will re-run and may not display any information.  

14. When finished with this view and would like to select a new filter just click the Filter tab. The previous filter 
will be populated as previously defined. Modify the filter or click Clear to start over.  

 

Saving a Filter 
 

Filters in Online Views can be saved using the Save Filter function on the Online Views screen. Previously 
saved filters can be viewed by using the Open Filter function. 

1. To save a filter, first create a filter in Online Views. Once Ok is selected for the filter and the data is 
displayed, select the Save Filter tab. Give the filter a Title and press the Ok button. The filter is now 
saved. 
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2. To open a saved filter, first select the Open Filter tab and the following dialog box appears. Select the 
saved filter and press the Ok button and the saved filter will appear. 

3. To update a saved filter, first select the Open Filter tab, then select the saved filter to update and press the 
Ok button and the saved filter will appear. Then select the Filter tab to make changes and click Ok. 

4. Then select the original filter from the Save Filter tab and click Update. This will update the saved filter 
with the changes just made. 

5. To update a saved filter and save it as another filter, first select the Open Filter tab and select the saved 
filter to update and press the Ok button and the saved filter will appear. Click the Filter tab to bring up the 
filter criteria. Make changes and click Save Filter, then give it a new title and click Save. There is now a 
new filter. 
 

Opening Online View Filters 
 

Online Views previously Saved by other users can also be viewed.  

1. After selecting Open Filter, use the dropdown arrow to select another user and a list of their saved filters 
will appear. Select a filter and click OK. 

2. Update another user’s saved filter and save it as the user’s own.  
3. When another user’s filter is displayed select Save Filter, give the filter a title and click Save. The filter will 

now also be saved under the user’s name. 

Creating and Responding to Review Issues 
 

The Review Issues facilitates communication between OFM budget analysts and agency analysts as errors, 
problems, or concerns arise, or just when further clarification is needed. It provides a means where either the 
OFM budget analyst or the agency analyst can create issues about a packet and carry on a threaded 
conversation about an issue, to include attachments and online view links as necessary. 

Creating a Response 
 

1. Go to View Packet List and choose a packet and click the Review Issues tab.  

 Note: Issues and responses can only be added to packets in review and returned status. Issues and 
responses can be viewed, but not changed in packets with approved status.  

 

 

2. In the Review Issues tab add an issue or response.  
• Add Issue: add a new issue.  
• Add Response: respond to an existing issue.  

 

 
 
3. To add an issue, select the Add Issue tab and the Add Issue dialog box will appear 
4. Describe the issue in the body of the dialog box.  
5. Give the issue a title that easily identifies it.  
 Note: The title is displayed on the review issues screen. The body of the issue can only be seen by 

selecting the “+”. 
6. Select who to notified in the E-Mail Notify box.  
 Note: For a dropdown list select the “…”.  
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7. To add an Online View Link to the new issue, click the Attachments and Links tab. Previously saved 
Online Views will be displayed in the Stored Filters box. Choose one or more Stored Filters to be 
displayed along with the Issue. Simply highlight the selection and click the right-handed directional arrow to 
move the items to the Selected Links box.  
 Note: Remove Online Views links from the Selected Links box by highlighting the link and clicking on 

the left-handed directional arrow.  
8. To add an Attachment, click the Attachments and Links tab. Select the Browse button to locate the file, 

click the Add button.  
 Note: To specify an Attachment Title, if an Attachment Title is not entered, it will default to the File 

name.  
 Note: Attachments can be Word, Excel, or PDF formats, and are limited in size to 3MB. 

9. When finished select the Save button. 
 

Responding to an Issue 
 

1. To respond to an issue, select an issue and the Add Response tab and the Add Response dialog box will 
appear.  

2. Enter the response. There is also an option to add attachments and links by selecting the Attachments 
and Links tab. This is the same dialog box that is used in the previous lesson when adding an issue. 
When finished select the Save button. 

Pre-Release Edit Checks 
 

TALS- AMR has a full range of edit checks that ensures the allotment meets all required standards and alerts 
agencies to other anomalies that may warrant a note to OFM. For many of the edits resulting in errors, the edit 
check will provide the user with a link to the data elements that are causing the error to facilitate review and 
corrections.  

1. From the View Packet List, run the AMR Pre-Release Edit Report, which is located in the upper right-hand 
corner of the screen.  
• Select one or more packets to run the AMR Pre-Release Edits. 

2. There are three types of edits;  
• critical 
• warnings and 
• informational edits  

3. The packet may be returned if the requested information is not provided.  
 

 Note: A number of the warning errors will prompt the user to provide an explanation in the packet for OFM 
about a particular pattern or condition in the allotments. OFM will be able to see these warning messages 
as well and will be looking for those comments 
 

 Note: There are a couple of edit checks that compares allotments to actuals. This edit check is only 
performed on an Operating Initial packet purpose type when the Operating Initial packet allotments 
deviate more than 10% from the historical actuals. When allotments deviate more than 10%, a warning 
message will display on the AMR Pre-Release report. Also included in this warning message is a link to a 
chart that will display the comparison. 
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The AMR Edit Report will open if there are errors. 
 

 
 
AMR Edit Report Detail 
 

Field Detail 
Agency Agency number and name 
Biennium biennium the packets are associated with 
Date and Time current date & time report was run 
Packet(s) displays packet number(s) 
Edit Level: Critical, Warning and 
Informational (#) 

Lists all errors & error count in the following order: 

• Type AMR or AFRS 

• Edit ## displays number, see Appendix 4 for complete listing of errors 

• Description displays written information to the nature of the error 
• The system won’t always provide a link depending on the type 

of error produced 
• Where Links to Online Views to go to the error 

• Print Print the report 

• Cancel Goes back to the view packet list 

 
1. Select the Online Views link—the link in the Where column. Online views will appear behind the AMR edit 

report so the report can be  minimized or canceled (recommend minimizing if more than one error) or click 
on the online views in the background and the error report will automatically be minimized.  
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• Selecting the online views link from the AMR Edit Report opens to the data that caused the error in 
online views. To fix the error, evaluate if the change needed is to the allotment information or if another 
action must be taken. For example, if the error says “the program index XXXXX does not exist in 
AFRS“, the fix may be setting it up in AFRS not changing it in TALS AMR.  

• Going to online views through the AMR Pre-Release edit opens to the data that caused the error only. 
However, when coming to online views through AMR Pre-Release Edits, there is not an option to 
change the online views filter.  

2. Try fixing an error: Select the magnifying glass and expand the grid to the level of detail where the error 
occurs. Select the coding structure check box and click Update. Change the amount and select Save, and 
then Cancel to close Update dialog box.  
 Note: For more information regarding the edits, see Pre-Release Edits, which identifies the Edit #, Edit 

Type (Critical, Warning, or Informational), and Description (and in some cases will give more detail 
about the edit than the Pre-Release Edit report does).  
 

3. Select the View Packet List breadcrumb at the top of the screen to return to the View Packet List screen.  

AMR AFRS Edit Checks 
 

After the AMR Pre-Release Edit checks has been run, corrected all critical errors, and make the necessary 
changes for warning messages, the next step is to run the AMR AFRS Edit checks.  

• The AFRS Edit checks will take a while to run (approximately 15 minutes).  
• There is an option to select one or more packets to run the AMR AFRS Edits. 
• Another option is if the packet is ready to submit to OFM, skip the AFRS Edit checks and instead select the 

Submit Packet(s). This option will run both the Pre-Release edit checks and the AFRS Edit check, if there 
are critical errors for either the Pre-Release or AFRS, the packet will not be submitted, and an edit report 
will be available. If the packet was not submitted due to an error, check the Most Recent Edit Report to 
view the error. 

 
1. Select a packet from the View Packet List screen that has passed all the Pre-Release critical errors. In the 

right-hand corner of the screen, select AMR AFRS Edits in the drop down, then select Run.  
 

 
 

2. If there are no critical AMR Pre-Release errors, this message will send. Click OK.  
3. If there are critical AMR Pre-Release errors, correct the critical AMR Pre-Release errors before the AFRS 

Edit check will run. 
 

 
 

• Once the Run button is selected a Traffic Light Indicator will appear in the row of the selected 
packet(s). 
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• When performing an AFRS edit check a yellow traffic light will be displayed while it is running 
through the edit checks. It will remain yellow until AFRS edit checks has finished. An e-mail will be 
sent indicating whether AFRS has passed or there are errors.  

• Refresh the screen; this can be accomplished by clicking on the View Packet List tab at the top of 
the page or the Rows Load button. If the packet has passed the AFRS edit checks, and the screen 
is refreshed the traffic light will disappear. If AFRS edit checks has failed a red traffic light will 
display. If a red traffic light is received, this means there are AFRS critical errors that will need to be 
corrected before submitting the packet to OFM. The red traffic light will remain until the AFRS 
critical errors are corrected and the AMR AFRS Edit report is run again.  

 
 Note: The AFRS error messages may be difficult to understand what needs to be corrected. If the packet 

has failed the AFRS edits check an email message will be sent. The message will state the following: The 
AFRS edit checks have been completed and errors have been found. Please view the “Most Recent Edit 
Report”. The Most Recent Edit Report can be found on the View Packet List screen on the right-hand side 
of the screen. The Most Recent Edit Report will display the AFRS and AMR edits and have a link to Online 
Views. From Online Views, view the data that caused the error. 

Submitting & Recalling Packets 
 

After all critical errors for AFRS and AMR Pre-Release have been corrected the packet can now be submitted 
to OFM.  

• The Submit process will run through both the AMR and AFRS edit checks, which will take a while to run 
(approximately 15 minutes). 

• Select one or more packets to run the Submit Packet(s).  
 
1. Select a packet from the View Packet List screen that has passed all the Pre-Release and AFRS critical 

errors. In the right-hand corner of the screen, select Submit Packet(s) in the drop down, then select Run.  

 

2. If there are no critical AMR errors, the following message will be sent confirming that the AFRS edit check 
is going to run. Click OK.  

 
 

• Once the Run button is selected a Traffic Light Indicator will appear in the row of the selected 
packet(s). When performing an AFRS edit check a yellow traffic light will display while it is running 
through the edit checks, it will remain yellow while running the AFRS edits.  

• After the AFRS edits have run (approximately 15 minutes) refresh the screen, this can be accomplished 
by clicking on the View Packet List tab at the top of the page or the Rows Load button. 
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3. When the packet is submitted, an email message is sent stating “Packet number XXXX for agency XXX 
has been submitted”.  

4. After the packet is submitted to OFM, the Traffic Light Indicator will change from yellow to green and the 
status will change to Pending.  

•  The packet will remain in Pending status until OFM has opened the packet.  
 
If the Submit has failed the following will happen:  
 
 Note: A red traffic light there are AFRS critical errors that will need to be corrected before submitting 

the packet to OFM. The red traffic light will remain red until the AFRS critical errors are corrected and 
the packet is submitted again.  

 Note: Use the AFRS error messages to understand what needs to be corrected in order to fix the error.  
 Note: If the packet has failed the AFRS edits check; the following email message will be sent: “The 

AFRS edit checks have been completed and errors have been found. Please view the “Most Recent 
Edit Report” for more information.” The Most Recent Edit Report will display the AFRS and AMR edits. 
Most edits will have a link to Online Views. From Online Views, data that caused the error is viewable.  
 

After all critical errors been fixed; perform steps 1 through 4 again to submit the packet.  

Recalling a Packet 
 

After a packet has been submitted to OFM, there is an option to recall a packet.  
• In order for a user to recall a packet, they must be set up with the security to submit a packet.  
• The Recall Packet function can only be performed on a packet in Pending status.  
• Once the packet has been recalled the packet is no longer viewable by OFM.  

 
1. Select a packet from the View Packet List screen that has been submitted to OFM and is pending status. 

Select the Recall Packet in the drop down, then select Run.  
2. A confirmation window will pop up, Select OK and the packet status will change to draft. 

Chart Features 
 

The Charts compare data for allotments and actuals. The Charts tab can be found at the top of the View 
Packet List screen.  

 

 Note: When selecting the Chart tab and viewing a chart, it is important to know the allotment data is 
only for packets in Pending, Review and Approved packet status.  

 Note: The Data Type dropdown provides a selection for Operating or Capital packets and will display 
accounts that exist in the allotment packets in the Account dropdown. 

 Note: Actual data is from the prior biennium. If there are months that are not closed from the prior 
biennium, the data included will be prior biennium allotments.  

 Note: Charts can also be found when running a Pre-Release Report for an Operating Initial Allotment 
packet only. However, the only time a chart can be viewed from the Pre-Release Report is if the data in 
the Operating Initial Allotment packet caused a warning edit. There will be a link to the Chart. The 
allotment data in this chart does include Draft allotment data from the selected Operating Initial 
Allotment packet.  
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Available Charts 
 

From the Charts tab view the following charts:  
 
1. Allotted vs. Past Biennium Actual Expenditures-by Account : By choice of displaying the information 

by percentages or dollars and selecting an account from the accounts contained in the Data Type packet 
selection being viewed.  

2. Allotted vs. Past Biennium Actual Cash Disbursements-by Account: By choice of displaying the 
information by percentages or dollars and selecting an account from the accounts contained in the Data 
Type packet selection being viewed.  

3. Allotted vs. Past Biennium Actual Cash Receipts-by Account: By choice of choice of displaying the 
information by percentages or dollars and selecting an account from the accounts contained in the Data 
Type packet selection being viewed.  

4. Allotted vs. Past Biennium Actual Revenue-by Account: By choice of displaying the information by 
percentages or dollars and selecting an account from the accounts contained in the Data Type packet 
selection being viewed.  

5. Allotted vs. Past Biennium Actual Expenditures-by Object: By choice of choice of Data Type packet 
selection to display the information by percentages or dollars and fiscal period.  

6. Allotted vs. Past Biennium Actual Expenditures-by Program: By choice of choice of Data Type packet 
selection to display the information by percentages or dollars and fiscal period.  

7. Allotment vs. Actual Current Biennium Activity – By Account: By choice of choice of Data Type packet 
selection to display Cash or GAAP data.  
• The system will run a biennial projection for an account. 
• There is a beginning balance; the actual information will be based on transactions posted in AFRS, 

unclosed AFRS months will be provided from the allotments in TALS-AMR. The allotment data contains 
only official packets and  includes operating and capital allotment data. Users will have the option to 
include allotment packets that are in Pending and Review statuses.  

• The chart displays the projected account balance for the entire account (all agencies). The user can 
export the chart; the exported chart will show the detail for the account by agency.  

• The user has the ability to export the data. The data will export into a text file. The user has the ability to 
open the text file using “Text Wizard”.  

Viewing Charts 
1. To view a chart, select the Charts tab.  

 Note: By default, the first chart that is viewable is Allotted vs. Past Biennium Actual Expenditures-by 
Account. 

 

 



 

The Allotment System – Allotment Management & Review User Guide (TALS-AMR) 

 

TALS-AMR Revised March 2022 41 of 43 

2. To view another chart, select the chart from the dropdown arrow at the top of the dialog page.  
3. Select the Format to view – Percentages or Dollars  

• By default, the Format is Percentages. 
4. The first four charts have another selection choice of Account – select the account to view.  

• The account choices will be the accounts for Operating data only and in Pending, Review and 
Approved Statuses. 

• The remaining two charts have another selection choice of Fiscal Period – select the entire 
biennium, or one fiscal year.  

• FY1 compares the first fiscal year of allotments to the first fiscal year of expenditures from the past 
biennium. FY2 compares the second fiscal year of allotments to the second fiscal year of 
expenditures from the past biennium.  

5. To print a chart, select the Print button at the bottom of the dialog box.  
• The charts print in Portrait, in order to change to Landscape, it will need to be change it manually.  

Running Reports 
 

There are two ways to view TALS reports, Enterprise Reporting (ER) and the Reports list on the View Packet 
Screen.  

Running Reports – View Packet List Screen 
1. The first way to run a report is through the View Packet List. See the reports listed below. Select a report 

and select the Run button. When running the reports this way the parameters are already set to the 
preferred view of the OFM budget analysts. Run and view a report exactly the way OFM budget analysts 
are looking at it if they choose it from this list of reports.  

 
 

Running Reports – Enterprise Reporting 
 

2. The second way to run a report is through Enterprise Reporting. This tab can be seen from any screen in 
TALS-AMR. This requires access to the Enterprise Reporting Portal.   

 

Enterprise Reporting is used to view the TALS-AMR reports. Once logged into ER, request the report using the 
standard ER report creation steps. Each report has a set of parameters available for that report. The detail 
reports will have more parameters than the summary reports. The defaults for the parameters have been set to 
a high-level view so there is  not a need to make a lot of selections to get a usable report. It is optional to make 
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additional lower-level selections to meet the report needs. The ‘Level of Detail’ parameters are used to select 
what level to view the data at, such as ‘Level of Detail for Program’ to view the data at the program, sub 
program, activity, sub activity, or task level. There are Expenditure, Revenue, Cash Receipts, Cash 
Disbursement, and Comparison reports available as well.  

Report List 
 

AMR001 – Allotment Expenditure Summary – provides a summary of expenditure and FTE allotment by 
program, account, account type, expenditure authority, and object for fiscal year and biennial periods. The 
report displays information in five categories: summary, allotted expenditures, unallotted, reserve, and 
comments.  

AMR002 – Allotment Expenditure Detail – provides a detail of expenditure and FTE allotment by program, 
account, account type, expenditure authority, and object by fiscal month, fiscal year and biennium. This report 
can be requested at any level the data was entered into TALS-AMR.  

• FTE is by GFS and other only – if detail by account is needed use the AMR002FTE report.  
 

AMR002FTE – Allotment Detail – provides a detail of the FTE allotments by account, expenditure authority, 
and object by fiscal month, fiscal year, and biennium.  

AMR003 – Allotment Revenue Summary – provides a summary of the revenue allotment data by account 
and category for fiscal year and biennial time periods.  

• The categories are State, Federal, and Private/Local.  
 
AMR004 – Allotment Revenue Detail – provides a detail of the revenue allotments by account, major source, 
and source by fiscal month, fiscal year, and biennium.  

AMR005 – Allotment Cash Disbursements Detail – provides a detail of the cash disbursements allotments 
by account by fiscal month, fiscal year, and biennium. 

AMR007 – Allotment Cash Receipts Detail – provides a detail of the cash receipts allotments by account by 
fiscal month, fiscal year, and biennium.  

AMR008-A – Allotment vs. EA Schedule (This Packet Only) – compares allotment expenditure and FTE data 
with the Expenditure Authority Schedule (EAS) and shows variances.  

AMR008-B – Allotment vs. EA Schedule (All Packets) – compares allotment expenditure and FTE data with 
the Expenditure Authority Schedule (EAS) and shows variances. 

AMR009 – Allotted Revenue vs. Expenditure Variance (Federal and Private/Local Funds Only) – 
compares federal and private/local revenue and expenditure data for the allotment and shows where the 
revenue and expenditures do not match as required by Generally Accepted Accounting Principles.  

AMR010– Allotted Revenue vs. EAS Revenue Variance – provides a comparison of revenue allotments to 
the expenditure authority schedule (EAS) revenue control numbers for fiscal year and biennial time periods.  

AMR011– Allotted Expenditures vs. Cash Disbursements – provides a comparison of allotted expenditures 
to cash disbursement allotments. The report displays the information by fiscal month, in spreadsheet form and 
in graph form.  

AMR012– Allotment Revenue vs. Cash Receipts – provides a comparison of revenue allotments to cash 
receipt allotments. The report displays the information by fiscal month, in spreadsheet form and in graph form.  
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AMR013– Allotted Revenue vs. Expenditures (All Accounts) – compares allotted expenditures by account 
with revenue by account.  
AMR014– Projected Monthly Cash Balance – enables OFM and administering agencies to determine if an 
account will have a temporary cash deficit during the course of the biennium based on actual cash balances to 
date plus proposed and approved cash allotments for the remainder of the biennium. This report will not 
include data from packets in Draft status.  
 
AMR015– Projected Fund Balance – shows the projected ending fund balance for each fiscal year based on 
the allotment data under review and previously approved. This report will not include data from packets in Draft 
status.  
 
AMR016– Projected Cash Balance – shows the projected ending cash balance for each fiscal year based on 
the allotment data under review and previously approved. This report will not include data from packets in Draft 
status.  
 
AMR017– Incremental Change from Previous Submittal – isolates changes within a packet that has been 
returned to the agency for revision and resubmitted to OFM for review.  
 
AMR018– Unanticipated Receipt Allotments – provides information to the legislative fiscal committees on 
executive spending authority granted to agencies by OFM.  
 
AMR019– Allotment Status– facilitates management of the allotment review process. It enables both OFM 
budget analysts, agency budget analysts, and the Legislature to view the status of allotments and summarizes 
the number of allotment packets by status and purpose.  
 
AMR020– Unanticipated Receipt Approval Request –This report is used to convey the required information 
to OFM and the Legislature when requesting spending authority for unanticipated receipts. It replaces the 
former B20-1 form. 

Additional Information – Help Desk 
For additional information about TALS – AMR please contact the OFM Help Desk at HereToHelp@ofm.wa.gov    
or call 360.407.9100 
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